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Some people use iPhoto for years without pulling down a single menu. But un-
less you explore its menu commands, you’re likely to miss some of the options 
and controls that make it a surprisingly powerful photo manager. Especially 

since some commands, like Export, appear only in menus.

Here’s a menu-by-menu look at iPhoto’s commands.

iPhoto Menu
This first menu, OS X’s Application menu, takes on the name of whatever program 
happens to be running in the foreground. In iPhoto’s case, that would be “iPhoto.”

About iPhoto
This command opens the “About” box containing the requisite Apple legalese.

There’s really only one good reason to open the About iPhoto window: It’s the easi-
est way to find out exactly which version of the program you have.

Preferences
Opens the Preferences window, which has five panels to choose from:

GENERAL
•	 Sources. Tell iPhoto how many months to show in the Last __ Months album, 

as discussed in Chapter 2.

•	 Show item counts. Have iPhoto display the total photo count, in parentheses, 
next to each album in the Source list.

	 	 iPhoto, Menu by Menu
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IPHOTO MENU
•	 Rotate. Change the setting of iPhoto’s Rotate button so that it spins selected 

photos counterclockwise instead of clockwise.

•	 Connecting camera opens. Choose the photo-downloading program that you 
want to open automatically when you connect a camera. iPhoto, of course, is 
the factory setting. But you may prefer to use the old Image Capture program. 
Or you may want nothing to happen automatically.

•	 Autosplit into Events. Specify how iPhoto splits imported photos into separate, 
time-grouped batches; page 38 tells all.

•	 Email photos using. When you send photos by email, do you want iPhoto to 
hand them off to your email program as file attachments, as it’s always done? 
If so, choose your email program’s name here.

Or do you want to use the embedded-in-the-message-body method, where 
you can add stylish frames and backgrounds to your photos, and where iPhoto 
itself does the emailing? In that case, pick iPhoto.

 TIP 	 You’ll probably be visiting iPhoto’s Preferences window fairly regularly, so remember the keyboard 
shortcut that takes you here: c-comma. You need to open Preferences every time you want to turn iCloud’s 
Photo Sharing feature on or off, for example.

APPEARANCE
•	 Photo Border. Add a thin black outline frame or a drop shadow to your thumb-

nails in the photo-viewing area.

•	 Background. Change the background of the photo-viewing area from white 
to black—or any shade of gray. This change will be apparent when you’re in 
Photos view.

•	 Events. Turn the little Event-thumbnail reflections on or off. Turning them off 
doesn’t save any space or even speed, really; it’s just a cosmetic option. 

•	 Organize View. Turn on “Show informational overlays” to superimpose a float-
ing, dark gray label on the screen while you’re scrolling to help you figure out 
where you are in your vast library. (It shows the date, or rating, or name of the 
photos whizzing by, according to your sort criterion.)

•	 Source Text. Set the size of text in your Source list to Small or Large (the latter 
is a little easier on the eyes).

ICLOUD
•	 My Photo Stream. Turn on this checkbox to see your iCloud Photo Stream inside 

iPhoto, as explained on page 13. When you do that, you get the following options:

•	 Automatic Import. Downloads your Photo Stream pictures to your Mac 
and creates a new Event named after the month and year when the photos 
were taken: November 2014 Photo Stream, December 2014 Photo Stream, 
and so on.
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IPHOTO MENU
•	 Automatic Upload. Syncs the photos you import into iPhoto on your Mac 

with your Photo Stream so you can view them on your iOS devices.

•	 Photo Sharing. Lets you share photos with other people, who in turn can con-
tribute photos, videos, and comments that you can see in iPhoto on your Mac. 
For the full story on photo sharing, see page 198.

ACCOUNTS
This panel lets you add your Facebook, Flickr, and email accounts in order to take 
advantage of all the fun ways you can share photos, whether that’s publishing them 
on the Web or sending fancy graphic emails. Chapter 8 tells all.

ADVANCED
A better name for this panel might be “Miscellaneous.” Here we go:

•	 Importing: Copy items to the iPhoto Library. As explained on page 15, iPhoto 
can track your photos no matter where they live on your hard drive—in their 
current folder homes—without duplicating them in its own library. You can think 
of this setting as the on-off switch for that feature.

•	 Edit Photos. This setting lets you choose which program you want to edit your 
photos in. Of course, the factory setting is iPhoto, though if you’d rather spend 
your editing time in, say, Photoshop Elements (or any other image-editing 
program), you can choose it here. 

 NOTE 	 When you edit a photo an external program, iPhoto makes a copy of your image to keep you from 
saving over your original (see page 117). You’ll find more than you ever wanted to know about editing in Chapter 5.

•	 Use RAW when using external editor. This is a rather high-end feature that 
means, “Open raw photos with Adobe’s raw-file editor,” as described on page 
149 of this book.

•	 Save edits as 16-bit TIFF files. Here’s another high-end feature. As you know 
from page 148, iPhoto ordinarily saves raw files as JPEGs once you’ve edited 
them. But many photographers object to that behavior because JPEG is a com-
pressed format that, in theory, can degrade the quality of the original photo. 
This option tells iPhoto to save such pictures in the TIFF format instead, which 
consumes far more disk space but doesn’t compress the photos.

•	 Look up Places. If your photos have embedded location coordinates (page 
103), choose Automatically from the pop-up menu here to have iPhoto match 
the numbers to actual place names on the map. Choose Never if you’d like to 
keep locations private (see the box on page 107 for more on privacy). 

•	 Include location information for published items. If you want location coor-
dinates to tag along with photos you publish on the Web in Flickr, Facebook, 
and so on, turn on this option. (Even if you choose Never in the Look up Places 
option, you can still turn this setting on.)
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IPHOTO MENU
•	 Automatically Bcc myself. Turn on this option if you want a copy of any emails 

sent from iPhoto to come to you, too, for your records.

•	 Print Products Store. If you suddenly pack up the family and high-tail it to 
Italy, you’ll need to change the country listed here before you order any printed 
products (calendars, books, cards, and so on). 

Empty iPhoto Trash
Purges the contents of iPhoto’s Trash, permanently deleting any photos, books, 
slideshows, and albums in it. There’s no turning back once you choose Empty iPhoto 
Trash: Your photos are gone, and there’s no Undo command. Think before you empty.

Learn about Print Products
This isn’t so much a command as it is a marketing ploy. It opens your web browser 
to a page on Apple’s website that regales you with the beauty of its books, cards, 
calendars, and prints.

Learn about Aperture
Yep, this is another marketing ploy to get you to take a look at Apple’s pro-level 
image editor. It sends you to a page on Apple’s website that shows you the wonders 
of Aperture. But be warned: In June 2014, Apple announced that they’re going to 
stop updating Aperture, so this menu item may disappear (and it’s not worth buying 
Aperture before it goes extinct). Instead, be patient and wait for the Photos app that 
Apple is currently working on, which they say will be fully compatible with existing 
iPhoto and Aperture libraries. Rumor has it that Photos will be released sometime 
in the first half of 2015.

Provide iPhoto Feedback
This command takes you to a form on Apple’s website where you can register com-
plaints, make suggestions, or gush enthusiastically about iPhoto.

Services
This menu belongs to OS X. Some programs add extra features in this menu, such as 
the ability to create a new Sticky Note from selected text in Safari, and so on. iPhoto 
doesn’t offer any extras, so the menu just says “No Services Apply.” 

Hide iPhoto, Hide Others, Show All
These aren’t iPhoto’s commands—they’re OS X’s. In any case, they determine which 
of the various programs running on your Mac are visible onscreen at any given mo-
ment. The Hide Others command is probably the most popular of these three. It 
zaps the windows of all other programs—including the Finder—so that the iPhoto 
window is the only one you see.
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FILE MENU
 TIP 	 If you know this golden OS X trick, you may never need to use the Hide Others command: To switch 
into iPhoto from another program, hold down the Option and c keys when clicking the iPhoto icon in the Dock. 
Doing so simultaneously brings iPhoto to the front and hides all other programs you have running, producing a 
distraction-free view of iPhoto.

Quit iPhoto
This command closes iPhoto, no questions asked. The program doesn’t even ask if 
you want to save changes, because as you’ve probably noticed, iPhoto doesn’t have 
a Save command. Like Filemaker Pro and other database programs, iPhoto—itself 
a glorified database—continually saves changes as you add, delete, or edit photos.

File Menu
Most of the commands in this menu involve creating new storage containers: albums, 
folders, books, slideshows, and so on (see Chapters 2, 9, and 6, respectively). This 
is also where you go to print.

New Album
Creates a new photo album in the Source list and prompts you to name it. (You 
can also create an album by pressing c-N or clicking the Create button in the main 
iPhoto window.) If you have photos selected when you choose this command, they 
hop right into your new album (which is why iPhoto no longer has a command called 
New Album From Selection.)

New Smart Album
Opens a dialog box where you can set up criteria for a smart album, as described 
on page 59.

New Folder
This humble command is your ticket to the all-powerful iPhoto feature: folders. A 
folder is a Source-list icon that can contain other icons, like albums, book layouts, 
and slideshows. See page 62 for details.

New Book, Card, Calendar, Slideshow
These super fun, pay-to-print projects are described in Chapter 9; slideshows are 
covered in Chapter 6.

Import to Library
Use this command to add photos to your iPhoto Library from your hard disk, a CD 
or DVD, or some other disk. Choose Add to Library, select the file or folder you want 
to add, and then click the Import button in the Import Photos dialog box. Keyboard 
shortcut: Shift-c-I.
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Switch to Library
This command lets you close the currently open library and open another one, as 
well as create a brand-spanking-new library.

Open Library in Aperture
If you own Apple’s pro-level image editor Aperture, you’ve got a neat trick at your 
disposal: you can open your iPhoto library in Aperture. Why should you care? Well, 
you might use Aperture for most of your photo organizing and advanced editing, 
for example, but wish you could order some of iPhoto’s calendars or cards, which 
aren’t available in Aperture. New in this version of iPhoto, iPhoto and Aperture can 
share the same library, relieving you of the need to copy photos from one library to 
another. (The box on page 314 has more.)

If you don’t have Aperture on your Mac, this menu item is dimmed.

Export
This command opens the Export Images window, whose panels offer the following 
ways of copying photos:

•	 File Export. Makes fresh copies of your photos in the file format and size you 
specify. You can export photos in their existing file format or convert them to 
JPEG, TIFF, or PNG format. You also can set a maximum size for the photos, so 
that iPhoto scales down larger photos as it exports them.

•	 Web Page. Publishes selected photos as a series of HTML pages that you can 
post on a website. The finished product includes an index page with clickable 
thumbnails that open individual pages containing each photo. See page 222 
for step-by-step instructions on using this panel to set image sizes and format 
the HTML pages.

•	 Slideshow. This option makes a copy of your lovingly handcrafted photo 
extravaganza and exports it to a video file perfectly sized for your chosen 
screen—whether it be an iPod Touch, iPhone, iPad, Apple TV, or computer 
monitor. Page 273 has details.

You can save yourself a trip to the Export menu by using the keyboard shortcut 
Shift-c-E. (By the way, you may find additional tabs in the Export dialog box if 
you’ve installed iPhoto plug-ins.)

Reveal in Finder
Curious where a photo lives on your hard drive? No problem. Choose File→“Reveal 
in Finder”→Modified File; iPhoto scours your hard drive, and then opens the folder 
in which the edited photo lives (even if it’s in the iPhoto Library package). 

Choose File→“Reveal in Finder”→Original File instead to locate the unedited original. 
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Close Window
Closes the frontmost window. If only the main iPhoto window is open, then this 
command quits the program. Keyboard shortcut: c-W.

Edit Smart Album
Lets you edit a smart album’s criteria. (Select the album before choosing this com-
mand.) When you click OK, iPhoto updates the smart album.

Order Prints
Use this command when it’s time to order up professionally printed copies of your 
pictures in a variety of sizes. Chapter 7 is all about making prints.

Print
Opens iPhoto’s Print dialog box, where you can print contact sheets, greeting cards, 
full-page photos, or groups of photos in standard sizes like 4" × 6" or 5" × 7". See 
Chapter 7 for details.

Edit Menu
The commands in this menu let you undo and redo changes, fiddle with various bits 
of info such as keywords and photo titles, as well as copy and paste adjustments 
you’ve made to one photo onto another. The menu’s Cut, Copy, and Paste commands 
operate on selected text and photos, just like you’d expect. 

Undo
Where would this world be without Undo? In iPhoto, you even have a multiple Undo; 
using this command (or its keyboard equivalent, c-Z), you can reverse your last 
series of actions in iPhoto, backing out of your bad decisions with no harm done. 
It’s nice to know that if you go too heavy on the contrast, send an important photo 
to iPhoto’s Trash, or crop out your grandmother’s ear, there’s a quick and easy way 
out. In fact, nearly any action you perform in iPhoto can be reversed with the Undo 
command. The menu command itself always spells out exactly what it’s going to 
undo—Undo Add Photo to Album, Undo Cropping, and so on—so that you know 
which action you’re backing out of. The one un-undoable action is emptying the 
iPhoto Trash: once you do that, your trashed photos are gone for good.

If you’re editing two photos side by side in iPhoto, note that the Undo command 
tracks your changes in each photo independently. For example, say you’re in Edit 
mode with the two pictures looming large in your window, and you’re clicking on 
each one separately to select it for fiddling. You crop and rotate the one on the left, 
and then select the one on the right to and fix some red-eye and adjust the contrast. 
As long as the right-side photo is selected, you can undo the contrast and red-eye 
adjustments—but if you click the picture on the left, you’ll find that the Undo com-
mand will take back only your earlier actions—the cropping and rotating. So keep in 
mind that each selected photo maintains its own private stash of Undos.
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Redo
Redo (Shift-c-Z) lets you undo what you just undid. In other words, it reapplies the 
action you just reversed using the Undo command.

Cut, Copy, Paste, Paste Location
These commands work exactly the way they do in your word processor; they help 
you edit photo titles, comments, keywords, or any other text fields. In addition, they 
have a few special functions when they’re used in certain parts of iPhoto.

•	 In an album (not the main photo library), you can select photos and use Cut 
to remove them from the album. (This doesn’t delete them from iPhoto, only 
from that particular album.) To move the photos to a different album, click the 
album’s name or click one of its photos, and then choose Paste.

•	 You can assign photos from the main iPhoto library to a specific album using the 
Copy and Paste commands. Select a photo, choose Copy, click the destination 
album, and then choose Paste.

•	 Cut, Copy, and Paste are all inactive when you’re in Edit mode (discussed in 
Chapter 5).

•	 The Paste Location command lets you paste the location coordinates you’ve 
copied from one photo—using the Copy command—to another. Chapter 4 has 
the scoop on using Places. 

Select All
This command (c-A) behaves in one of two ways, depending on when you use it:

•	 In the thumbnails view, it selects all thumbnails visible in the viewing area—either 
those in the Events view or the Photos view.

•	 When you’re editing photo titles, descriptions, keywords, or any other text fields, 
this command selects all the text in the field you’re editing.

Select None
As you would expect, this command is the opposite of Select All. The only practical 
way to use this command is to employ its handy keyboard shortcut, Shift-c-A, to 
quickly deselect a group of photos without having to click with your mouse.

Copy/Paste Adjustments
These commands let you copy the adjustments you’ve made on one photo to an-
other, which is helpful if the photos were taken in similar lighting conditions. They’ve 
even got handy keyboard shortcuts: Press c-Option-C to copy adjustments and 
c-Option-V to paste them.

Find
Just puts your blinking insertion point into the Search box at the bottom of the 
iPhoto window. Cute—real cute.
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PHOTOS MENU
Font
This submenu offers quick access to text-formatting options like Bold, Italic, and 
Show Fonts (which opens the standard OS X Fonts panel). It also offers Copy Style 
and Paste Style commands, which let you apply the formatting of one text blob 
onto another one without having to go through all the same formatting steps. These 
commands aren’t of much use except when you’re using iPhoto’s book/calendar/
card-designing feature (Chapter 9). You can’t change the font that the program uses 
to display titles, descriptions, or keywords.

Spelling
Use the Spelling and Grammar commands on this item’s submenu to check for mis-
spelled words and poorly written sentences within iPhoto. It’s primarily useful when 
you’re typing in the text paragraphs and photo names for books and calendars that 
you plan to order, as described in Chapter 9. Even then, you may find this feature 
a bit cumbersome.

Special Characters
Opens a panel of non-alphabetic symbols for entering into text boxes.

Photos Menu
This menu’s commands come in handy when you’re working with—you guessed 
it—photos. Most of the time you need to select the photos, using any of the methods 
described on page 46, before choosing from this menu.

Adjust Date and Time
Opens a dialog box where you rewrite history by modifying the date and time stamps 
on the selected photos.

Batch Change
Opens a dialog box where you can apply a new title, date, or comment to any number 
of selected photos. See page 64 for details.

Rotate Clockwise/Counterclockwise
You can use the two Rotate commands—Clockwise or Counterclockwise—to rotate 
selected photos in 90-degree increments, switching them from landscape to portrait 
orientation as needed. However, the Rotate menu commands are by far the least 
convenient way to rotate photos. Here are a couple of alternatives:

•	 Press c-R to rotate the selected photos counterclockwise, or Shift-c-R to 
rotate them clockwise.

•	 Control-click (or right-click) a photo or a thumbnail, and then click Rotate in the 
shortcut menu. Option-click the Rotate button to reverse the direction of the 
rotation. (You specify the “main” rotation direction in iPhoto’s General prefer-
ences [page 124].)
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My Rating
Lets you apply a rating of one through five stars to selected photos. See page 86 
for the full story on this feature.

Edit Photo
This command transports you into Edit mode (page 117). Choosing this command 
has the same effect as pressing c-E.

Flag Photo
Marks the selected photos with a tiny orange pennant. What it means is up to you: 
“Edit me later,” “Candidate,” whatever. Chapter 3 has the scoop.

Hide Photo
Makes the selected photos disappear so you don’t have to stare at them, which is 
a great way to cull your library without actually deleting anything. See page 47 for 
details.

Detect Missing Faces/Rescan for Location
As described in Chapter 4, iPhoto scans your photos as it’s importing them to see 
whether they contain faces, and if they do, whether they match the faces you’ve 
tagged. If it misses one (or many), you can use this command to have it take another 
look. 

Similarly, choosing “Rescan for Location” makes iPhoto rescan your photo(s) to see 
if it can determine where they were taken. 

Duplicate
Just as in the Finder, this command creates a duplicate of whichever photo is selected 
and adds it to the library. And also just as in the Finder, the keyboard shortcut for 
this command is c-D. 

If you select multiple photos, then this command makes iPhoto duplicate all of 
them. If an album is selected (and no photos are), this command duplicates the 
album itself. The copy appears at the bottom of the Source list, named Album-1 (or 
whatever number it’s up to).

Move to Trash
Moves the selected photo(s) to iPhoto’s private Trash, a holding bin for files you 
plan to permanently delete from your library. Instead of choosing this command, 
you can just drag thumbnails onto the Trash icon in the Source list; Control-click 
selected photos and choose “Move to Trash” from the shortcut menu; or press c-
Delete. (They’re not actually deleted until you choose iPhoto→Empty iPhoto Trash.)
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EVENTS MENU
 TIP 	 When you’re viewing the contents of iPhoto’s Trash and you have at least one thumbnail selected, the 
“Move to Trash” command changes to read “Put Back.” Choosing this command moves the selected photo(s) out of 
the Trash and back into your library. The keyboard shortcut is the same as the one for “Move to Trash”: c-Delete.

Revert to Original
This command restores edited photos to the condition they were in when you first im-
ported them into iPhoto, reversing all the cropping, rotating, brightening, or anything 
else you’ve done (although it leaves titles, comments, and keywords undisturbed). 

This command is active only if you’ve edited the selected photo at least once. If the 
“Revert to Original” command is dimmed out, it’s probably for one of these reasons:

•	 You don’t have a photo selected.

•	 The photo you’ve selected hasn’t been edited, so there’s nothing to revert to.

•	 You edited the photo outside of iPhoto in an “unauthorized” way (by drag-
ging the thumbnail to the Photoshop icon in the Dock, for example), so iPhoto 
never had the chance to make a backup of the original version, which it needs 
to revert the file.

On the other hand, it’s totally OK to edit photos outside of iPhoto—still activat-
ing the “Revert to Original” feature—if you do it by double-clicking the photo’s 
thumbnail rather than dragging it, or by Control-clicking (right-clicking) it and 
choosing “Edit in external editor” from the shortcut menu.

 TIP 	 When you have a raw photo (page 148) selected, the “Revert to Original” command changes to “Reprocess 
RAW,” which means the same thing.

Events Menu
You can read all about Events—indeed, all about this menu’s commands—in Chapter 
2. But in short, an Event is a batch of photos that were all taken at about the same 
time; the premise is that it makes a lot of sense to organize photos by wedding, 
party, tournament, or whatever.

But Events are also extremely malleable. You can arbitrarily create them, split them, 
merge them, and so on. For example:

•	 Create Event. Moves the selected photos into a new, untitled Event.

•	 Create Event From Flagged Photos. Moves all flagged photos (page 73) into 
a new, untitled Event.

•	 Split Event. Breaks the currently displayed Event full of photos in two, using 
the first highlighted thumbnail as the split point. This command then changes 
to Merge With Above, in case you want to rejoin the two. 
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SHARE MENU
•	 Make Key Photo. Uses the highlighted picture as the key photo (page 35), the 

thumbnail that represents an entire Event “stack” when displayed in Events view.

•	 Add Flagged Photos To Selected Event. Moves all flagged photos (page 73) 
into the currently open Event—a handy way to round up photos from all over 
your library.

•	 Autosplit Selected Events. Splits the selected Event into smaller ones, based 
on when those photos were taken. (You’d use this command if you didn’t use 
the Autosplit option when you imported these pictures.) It’s available only in 
Event view, and it determines which time blocks to use as Event delimiters ac-
cording to your selection in iPhoto→Preferences.

Share Menu
The Share menu duplicates some of the options that appear when you click the 
Share button on the iPhoto toolbar, and includes commands for buttons that used 
to live on the toolbar in iPhoto ‘09. (The menu items are the same as they were in 
iPhoto ‘09, though they’re shuffled around a bit.) 

iCloud, Messages, Email, Flickr, Facebook, Twitter…
Choosing one of these commands is exactly the same as clicking the Share button 
on the toolbar below the main iPhoto window, and then clicking the corresponding 
option. See Chapter 8 for details on emailing photos and online sharing.

View Menu
This menu lets you change the order of your photos in the main viewing area, and 
tell iPhoto what kind of information you want displayed along with each picture.

Titles, Ratings, Keywords, Event Titles
Select these commands to display titles, star ratings, keywords, or Event-name info 
in the main photo-viewing area. Titles, stars, and keywords always appear beneath 
each thumbnail; Events are denoted by horizontal lines, tiny key-photo icons, and 
flippy triangles.

You can turn each of these four options on or off, in any combination, by repeatedly 
selecting it or by using the corresponding keyboard shortcuts: Shift-c-T for Titles, 
Shift-c-K for Keywords, Shift-c-R for Ratings, and Shift-c-F for Event Titles (it’s 
F because Events used to be called Film Rolls). A checkmark next to a menu item 
shows that it’s currently turned on.

Hidden Photos
Makes all photos you’ve hidden reappear. Choose this command again to make 
them vanish.
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Sort Photos
Determines how iPhoto sorts the photo thumbnails in the viewing area. You have 
several options:

•	 By Date. Arranges the photos chronologically based on their creation dates.

•	 By Keyword. Sorts your photos alphabetically by the first keyword you’ve ap-
plied to each. (Photos with no keywords appear at the top of the list.)

•	 By Title. Uses the titles to sort photos alphabetically.

•	 By Rating. Arranges all your pictures by how good they are, from best to 
worst—at least, if you’ve taken the time to apply star ratings to them (page 86). 
Unrated photos appear at the bottom.

•	 Manually. Lets you drag your photos into any order you like. (This choice is 
dimmed unless you’re in an album. In the main library, you have to use one of 
the first two options.)

•	 Ascending, Descending. Reverses the sorting order, no matter which criterion 
you’ve specified above. For example, if you’ve sorted by date, it puts the oldest 
photos at the top rather than the newest.

•	 Reset Manual Sort. What if you’re in an album, you carefully drag pictures into 
a custom order—and then you accidentally sort the whole thing alphabetically? 
This command restores the manual positioning.

Info
This command opens the Info panel where you can see all manner of information 
about your photo. It’s discussed at length on page 63. 

Project Settings
Once you’ve created a book or calendar project, this new command summons a panel 
with a slew of project-specific settings you can tweak. For example, if you’re design-
ing a calendar, you can change the start month/year, include national holidays (or 
not), import birthdays from iCal, and so on. Page 246 has more about this command. 

Layout Options
This command is only available when a project is active in your Source list. Choose 
it to open a panel that lets you change page-layout options, such as background 
color and how many photos appear on a page (see page 237).

Design Options
This command is also available only when a project is active in your Source list. It 
opens a panel on the right side of the iPhoto window that lets you choose from a 
variety of page configurations for calendars, books, and cards. 
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WINDOW MENU
Photo Pane
This command opens a pane containing thumbnails of the photos you’ve designated 
as part of a particular project (you either selected them before creating the project 
or dragged them onto the project’s icon in your Source list). This panel makes it 
easy for you to drag them onto your project pages. 

Photo Size
This submenu lets you specify how big the thumbnails are in the above-mentioned 
Photo Pane. You’ve got two choices: Small and Large. 

Enter Full Screen
Opens Full Screen mode, which is shown on page 23.

Window Menu
This menu is filled with the standard OS X window-manipulating commands.

Minimize
Collapses the frontmost iPhoto window into the Dock, in standard OS X fashion, as 
though you pressed c-M or clicked the yellow Minimize button in the upper-left 
corner of any window.

Zoom
Zooms any iPhoto window to fill your entire screen (although it’s nice enough to 
avoid covering up your Dock). Choosing this command is the same as clicking the 
green Zoom button in the upper-left corner of any iPhoto window. If you choose 
this command (or click the Zoom button) again, the window shrinks back to its 
original proportions.

Manage My Keywords
Opens the Keywords window described on page 80.

Manage My Places
Opens the window where you can edit your My Places list when precisely geotag-
ging your photos, as described in Chapter 4.

Bring All to Front
Every now and then, the windows of two different OS X programs get shuffled to-
gether, so that one iPhoto window is sandwiched between, say, two Safari windows. 
This command brings all your iPhoto windows to the front so they’re not being 
blocked by any other program’s windows. (Clicking iPhoto’s icon on the Dock does 
the same thing.)
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HELP MENU
[Window Names]
At the bottom of the Window menu, you’ll see the names of all open windows. The 
main iPhoto window is, of course, called “iPhoto.”

Help Menu
You know all too well that iPhoto comes with no user manual; that’s why you’re 
reading this book! What official Apple documentation you do get appears in this 
menu. (Hint: It ain’t much.)

•	 Search. When you type a word or phrase into this box, the program (eventually) 
produces a list of where those word(s) appear in iPhoto’s menus or iPhoto’s Help 
system. If it doesn’t find a match, it says “No Results Found.”

•	 iPhoto Help. This command opens Apple’s Help Center program, which is pretty 
limited, but at least it includes a searchable reference in case you forget how 
to do something (or lose this book).

•	 Keyboard Shortcuts. This is just another link into the iPhoto Help system, but a 
particularly valuable one: It takes you to a table showing more than 50 keyboard 
shortcuts in iPhoto. This is one help page that’s worth printing out.

•	 Service and Support. Fires up your web browser and opens Apple’s main 
iPhoto support page, where you can participate in forums, watch video tutori-
als, and more. 


